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Introduction 
Welcome to the Save the Cat! 4 User Guide. Our intent is to give you the information 
you need to take advantage of all the features in Save the Cat! 4 while respecting your 
time by keeping this guide as short and sweet as possible. But there is a lot to cover.


Customer Service 
If you have questions about your subscription or other Save the Cat! offerings, please send an 
email to customerservice@blakesnyder.com.


Tech Support 
If you have questions about how to use Save the Cat! or run into a problem, send an email to 
tech@blakesnyder.com. We’ll get back to you as quickly as possible.


We want to solve any problems you may encounter. The only way we can solve a problem is if 
we can duplicate it.


In your email, describe the problem you encountered and exactly what you were doing at the 
time. For the most effective tech support, be as detailed as possible. Screenshots are helpful. If 
you were presented with an error message that has a Details button, click it. Copy and paste 
the info into the email and send it along.
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Activate 
In order to use Save the Cat! you must activate using the serial number you received when you 
signed up.




Fill in your name and email address so we can look up your serial number for you if you should 
misplace it. 


You can copy your serial number from the email you received then click the paste button next 
to “Serial Number:”. Or, just type it in. 


Click “Activate.” If you’ve entered everything correctly and the serial number is valid and active, 
you are on your way.


Manual Activation 
If you have a bad or no internet connection, click the Copy button then paste the Code into an 
email along with your serial number and sent it to tech@blakesnyder.com. We’ll process it and 
send you an Activation Code that you can paste in. Paste it in then click “Activate Using 
Activation Code” and you should be good to go.


Deactivate 
After you activate a “Deactivate” button that will appear on the left side of this window. If you 
need to deactivate for some reason such as upgrading your plan, click it to deactivate your 
current serial number. Use your new serial number to activate your new plan.
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Essentials 
If you signed up for Essentials, your opening screen will look like this.


There’s that “Deactivate” button I was talking about. On the left, just below the serial number.


Start a New Project 
Save the Cat! has three basic project types with just a couple of differences.


Movie 
Uses the famous Blake Snyder Beat Sheet and the word processor is formatted for a 
screenplay with elements for Scene Headings, Action, Character, Dialogue, Parenthetical, and 
Transition.


Novel 
Uses the famous Blake Snyder Beat Sheet with some modifications based on the book, “Save 
the Cat! Writes a Novel” by Jessica Brody. The word processor is formatted for a manuscript.


TV 
Uses the famous Blake Snyder Beat Sheet adapted for a five act drama. And, of course, the 
word processor is formatted for a screenplay. Just like for a movie.


Decide what kind of project you’re working on and click a button. You’ll be prompted to select 
the location and a title for your file. You could also use the options under the File menu for this 
but, why bother. You have these nice buttons right here.


Open a Project 
You may already have projects on your computer. Click “Open Project” and select one to open 
it.
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Recent Projects 
If you’ve opened a project, your main window will look like this.


The last ten projects you’ve opened will be listed. If you hover your mouse over a Recent 
Project, a star will appear next to it. Click the star to add the project to your Favorites. Then it 
will look like this.
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Premium 
This plan adds a new project type.


Novel by Chapter 
This type of project doesn’t use a beat sheet. Instead you set up multiple sections for your 
novel with any number of chapters within each section. The board, where you plot out your 
story, will have a row for each section divided up with a section for each chapter.


And, of course, the word processor will be formatted for a manuscript.


All plans include characters and locations. The Premium plan adds two new entity types:


Things 
Things are objects that play an important role in your story. You know, like the ring in the “Lord 
of the Rings” series.


Relationships 
Is there ever a story that doesn’t involve relationships? I know you’re thinking about people 
relationships. But, in Save the Cat! you can establish relationships that include Characters, 
Locations, and Things. You can even add in the conflicts that exist in the relationship.


Please take note that Things and Relationships are only included in the Premium and Pro 
plans. If you see something about Things or Relationships and you have the Essentials plan, 
just ignore it. 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Pro 
This plan adds three new project types.


Movie Series 
This is where you’ll develop that next great movie franchise. You’ll add groups of movies with 
any number of movies within each group. 


You’ll have a board with a row for each group divided into sections for each movie within the 
group. You can track character arcs and other important story elements across the entire 
series. 


You’ll also be able to develop each individual movie with its own beat sheet and board while 
sharing the Characters, Locations, Things, and Relationships across the entire series with 
unique set-ups and pay-offs for each individual movie.


TV Series 
This is where you’ll develop that hit tv series that runs for the next ten years. You’ll add 
seasons and any number of episodes within each season. Within reason.


Just like with a Movie Series, you’ll have a board with a row for each season and a section for 
each episode within a season. 


Develop each episode with its own beat sheet and board, all in the same project.


Novel Series 
This is where you’ll develop that next “Harry Potter” series. You’ll add groups of novels with 
any number of novels in each group. The series board also applies here as well as the 
individual novel beat sheets and boards.
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Resources 
We have a few resources that you might find helpful. These can be found under the Help menu.


Save the Cat! Website 
Check out the website for all the latest Save the Cat! news, blogs, and all things Save the Cat!


stcTV 
Find how-to videos, instructional videos, update briefings and other videos here. 


Advice From the Cat 
Find useful tips and thoughts about Save the Cat! concepts and methodology.


Download Sample Files 
Check here for great sample files from movies, tv series, and novels. As more are added, they 
will magically appear.


“Save the Cat! Strikes Back” Chapter 3 
Yes. It is the actual chapter 3 from the book.  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Make It Your Own 
Before we dive in to the nitty gritty of how to use Save the Cat! to develop your story, I want to 
show you some ways you can customize Save the Cat! to make it fit your own style.


Themes 
Now this is fun. And, since Themes involve the visual, to make them easy to find, Themes are 
under the View menu. 


We have included professionally designed themes or color schemes for your inspirational 
pleasure. Currently, you will find three new themes and the Legacy theme from version 3. And, 
we’ll be adding new themes in the future.


Select a theme at any time to see which one inspires you the most or suits your current mood.


Manage Themes 
Not only do we have some preset themes, you can also create your own. You won’t believe the 
flexibility you have when it comes to creating your own theme. To find out, click the View menu 
then Themes, then Manage Themes.


Add your own theme by clicking the 
“+” button next to the drop down. 
Give it a name and play till your 
heart’s content. 


I strongly suggest you have a project 
open when you do this so you can 
see how the changes will look.


Be sure to scroll down the list to see 
all of the things you can set colors 
for.


Cork/Background 
You can also use a cork, white cork, 
or chalkboard background for the 
Board and/or the Notes/Attachments 
board at the bottom of the main 
window. Or, leave out the stylized 
background and just select a color for 
the background.
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Zooming 
Everyone’s eyesight is different so we’ve added zooming. You can zoom from 75% of standard 
to 150% of standard. 


If you find a setting you like, click the Save the Cat! 4 menu, then Master Preferences, then 
Preference Settings and, finally, Default Zoom Percentage. This will open.


Move the slider to the desired percentage and click “Save”. Any new project you start will be 
set for that zoom percentage. By the way, the window is this color because of the Theme I 
have selected.


You can also set the zoom percentage within a project. That’s under the View menu when you 
have a project open.


Tool Tips 
You’ll find that, in a lot of places, when you hover the mouse over something a tool tip will likely 
pop up. Some of them can be kind of long since they tell you a lot of information. So, read 
quickly.


Once you’ve seen most of them or have learned enough that you don’t need them, you can 
turn them off. Uncheck the option Show Tooltips under Master Preferences, Preference 
Settings.


Master Preferences 
Save the Cat! has many things you can configure. Most of these are categories or types of 
things. For example, character types such as Main Characters, Supporting Characters, and 
Extras. This list may or may not work for you. Never fear. You can create your own list. 


Master Preferences are copied into every new project. That allows you to make changes that 
are unique to a specific project without messing up your carefully constructed Master 
Preferences. Which brings us to…


Project Preferences 
As I stated, these are the categories and other settings that are unique within a project. You 
can make all the tweaks for the project without messing up your future projects. 


You do have the option, when working in your Project Preferences, to also update your Master 
Preferences. So, if you come up with a great new category, you can add it once instead of 
twice.


So, how do you manage a list of categories? See the next page.
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Managing a List of Categories or Types 
I’ll show one example and save you the boredom of looking at twenty different examples that 
all work the same. I’ve selected Character Types. Some types have two colors to pick. 


Add Item 
Click the “+” button. Type the title for the item and 
click “Save.”


Edit Item 
Double-click the row to edit, change it, and Save it.


Delete item 
Drag it to the trash can.


Change the Color Code 
Click the color box and pick a color.


Rearrange the Order 
Drag a row to a new location until you see a blue line between rows. That let’s you know you 
can drop it there. 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Configurable Types/Categories 
Here is a list of the types you can set up to fit your writing style and needs.


Character Types

Obviously this is how you organize and color code your characters. Separate the main 
characters (the stars) from the supporting characters. Or, in any other way you like.


Relationship Types

Organize and color code the many relationships in your story.


Relationship Member Types

Within a relationship, each member of the relationship, whether a character, location, or thing 
can be identified as to their role in the relationship. For example, the man may be the boyfriend 
and the girl the ex-girlfriend who is stalking her ex. Or, in a relationship between a character 
and a thing, the character may have the role of Stolen By because the person stole the thing.


Entity Fact Types

This is how you categorize and organize all the facts for a character, location, thing, 
relationship, set-up, or pay-off. Facts are exactly what you think: birth date, place, occupation, 
architect of a location, if relevant. Anything that builds the backstory.


For those working in tv, this is like the Bible where you keep all the facts that have or have not 
been revealed in previous episodes so that viewers aren’t pointing out mistakes.


And, because different types of entities would have different types of facts, you have separate 
lists for each of those entities. Characters have their own list, locations have their own list, etc.


Tracking Types

This is cool. All the important things that change and evolve through the course of a story can 
be categorized and organized using the tracking types. For example, if a character’s health is a 
part of the story, you can add a health tracking item for the character and describe how their 
health evolves over the whole story. Then, you drop that character onto the Board at the points 
in the story where something changes regarding their health and you note what that change is 
that takes place at that point in the story.


You have separate lists of tracking types for characters, locations, things, relationships, set-
ups, and pay-offs. 


Entity Note Types

Your project has a section for general notes where you can keep notes that aren’t necessarily 
related to a particular character or location. You can also keep categorized notes for characters 
and other entities. 


In fact, you have separate entity note type lists for beats, scenes, characters, locations, things, 
relationships, set-ups, and pay-offs.
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Entity Attachment Types

Just like you have a section for general notes, there is also a section for general attachments. 
You can also add categorized attachments that relate to specific characters or other entities. 


You have separate entity attachment type lists for scenes, characters, locations, things, 
relationships, set-ups, and pay-offs.


Scene Card Color Codes

Each scene card has up to six color codes. You can filter the Board so that it only shows 
scenes that have a particular color code attached so you can really focus in on specific 
aspects of your story. You’ll manage those color codes and what they mean here.


Sequence Types

Scenes can be combined into a sequence. For example, a car chase may consist of several 
scenes where the chase travels through several locations. Instead of having all those scene 
cards on the board, they can be combined into a sequence. 


Each sequence type can be assigned a unique color so you can tell at a glance what type of 
sequences you have on the Board.


Label Types

Sometimes you just need something on the Board that isn’t a character or a scene or other 
fixed entity. Maybe you’re working on a tv series and you want to make notes about how the 
beats work across the first season. Or, you want to make a note to include a special effect at 
some point. You do this with color coded labels that you manage here.


Note Types

These note types are for the general notes that you keep in the general notes/attachments 
section at the bottom of the main window. In the previous version of Save the Cat! you were 
limited to a fixed number of note types. Not anymore. Organize your notes anyway you like.


Attachment Types

See Note Types as these are basically the same.


Other Things to Configure 

Sync Beat Scene Cards with Beats

When a new movie, novel, or tv episode project is started a Scene card is created for each 
Beat. Fifteen of them to be precise. If this option is checked and you start a new project, the 
Beat Scene cards will be linked to the Beats. If you change the description of the Beat, it will 
change the description of the linked Scene card. And vice versa. 


If you don’t want the descriptions to change, uncheck this option. This is a Master setting that 
gets copied into each new project so you can disable/enable it for each project individually.
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Optional Scene Cards

This is a Master setting only. When you start a new project, in addition to the Beat Scene 
cards, a number of optional Scene cards can be added as well. You can decide which of the 
groups of optional Scene cards will be added by checking or unchecking the following items: 


Set-up - Home, Work, Play

Debate - Home, Work

Fun and Games / B-Story

Bad Guys Close In - Internal / External

Five Point Finale


Page  of 19 64



Save the Cat! ® 4	 User Guide

Make It Your Own - Part Deux 
Time to open a project so you can see how you can configure your workspace.


Sections 
So we can communicate effectively, you need to be aware of the sections of the main window: 
Title/Logline across the top, Beats section on the left (even though it also has the tabs for 
characters, locations, things, relationships, set-ups, and pay-offs), the Board in the middle, the 
Litter Box on the right and the Notes/Attachments section across the bottom.


In case you’re wondering what the Litter Box is, it is a place you can put things that you may 
not keep in your story but don’t want to throw away. You’ll drag them off the Board and into the 
Litter Box. You can always use a pooper scooper and put them back onto the Board. Just 
kidding. Drag them out of the Litter Box and back onto the Board.


Resizing

See the horizontal divider just below the Title/Logline section? Drag that up or down to 
decrease or increase the size of the Title/Logline section.


There is another horizontal divider at the top of the Notes/Attachments section. Drag that up or 
down to increase or decrease the size of the that section.
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Show/Hide

You can hide individual sections in order to make more room for other sections. You can hide 
and show each of the four sections that surround the Board.



Due to the nature of the Mac vs. Windows, this works a little differently on each 
platform. 


On the Mac, click this button on the tool bar. A drop down will be displayed 
with a button for each of the four sections you can hide or show.


On Windows, click one of the four buttons on the toolbar.


Full View

You can also put one section in Full View mode which hides all other sections, making the 
selected section fill the window.



The sections you can put into Full View are: Title/Logline, Beats Section, The 
Board, Notes/Attachments.


On the Mac, click this button on the tool bar,. A drop down will be displayed 
with a button for each of the four sections you can put into full view.




On Windows, click one of the four buttons on the toolbar.


Hint: On each set of four buttons, the dark section indicates to which section 
that button applies.
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Unlocking Your Story 
We’ve been through a lot together so far. I just wanted to show you how you can turn Save the 
Cat! into the most effective tool for you. Not any other writer. Just you.


Let’s get started at how you use Save the Cat! to unlock that Oscar-winning screenplay, that 
Emmy-winning TV show, or that Best-Selling novel.


We’re going to start with your basic stand-alone project. We’ll talk about a series later. Within a 
series, however, the things we’ll go over now will also apply when you open an individual story 
within the series. So, if you have the Pro Plan, pay attention. 

You’ve started a new project for a Movie, TV Episode, or Novel. 


Hints 
Before we get into the details, you may have noticed the little white dots. Kind of hard to see in 
this screenshot but they have a little “i” in them. Stands for “info.” If you want to know more 
about something, click the info-dot. 


If you look closely in the Logline box, you’ll notice some text. Don’t worry, we aren’t trying to 
write your longline for you. In various places, like the logline box, we’re showing the hint that 
you will also find when you click the info-dot. It will go away as soon as you click in the box or 
start typing.


Title 
The Title fills in based on the name you gave the file when you started the project but you can 
change it. If you make a copy of the file to start a drastically different version and name the file 
“copy” or something like that, you can still go in and change the title to the correct title.
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Logline(s) 
The Logline, of course, is a summary that, when someone reads or hears it, they can’t wait to 
see your movie or read your novel. A great Logline is not easy to come by so we have some 
tools to help. 

You can write multiple versions of your Logline until you have one where you feel like you’ve 
really nailed it. And, we’ve provided a couple of templates to help you get started. 


Add a New Logline

Click the Loglines icon on the toolbar or the Story menu then Loglines and select which kind of 
Logline you want to start with: Blank, Short Form Template, Long Form Template.


Copy Your Logline

If you think you’re close but want to tweak your Logline without losing it, select New Logline 
From Copy.


Delete Logline

If you just hate the Logline that is staring you in the face, select Delete Current Logline to get 
rid of it.


Switch Loglines

Now that you have several loglines, how do you switch between them? Same menu or toolbar 
button. When you click it you’ll see the beginning of your other loglines under a sub-heading: 
My Other Loglines. Pick the one you want to switch to. If you only have one, there won’t be any 
others shown, obviously.


Beats 
You may remember in the previous version of Save the Cat! you had to fill in the Title, Logline, 
and pick a Genre before you were allowed to move on to the Beats. No longer. Whenever and 
wherever creativity strikes, you can follow. If you have a great idea for a Beat before you even 
start working on your Logline, go for it.


Before we go into getting your individual beats figured out, let’s back up to the beat sheet.


Multiple Beat Sheets 
You can now create multiple versions of your beat sheet. Each beat sheet has its own Board. 
Actually, multiple versions of the Board, but we’ll come back to that later.


You can start with a blank beat sheet selecting from one of the three types of beat sheets. 
Selecting a different beat sheet style won’t change the overall style of your project. In other 
words if you’re working on a movie, selecting the novel beat sheet won’t change your project 
to a novel. 


Start a new beat sheet by clicking the Beats toolbar button or the Story menu then Beats and 
start a new blank beat sheet. Finally, pick the style you want to try.


You can also start with a copy of your current beat sheet. That way you can make some tweaks 
but not have to start from scratch.
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After you add the new beat sheet, it will be added to the dropdown list in the Beat Sheet 
selector shown below and be flagged as the active beat sheet.


Change Beat Sheet Title

To make it easier to keep your versions straight, you can change the title of each beat sheet. 
Just click in the dropdown box and change it. You’ll be asked to confirm the change, of course.


Pages

Not sure if you’re writing a feature film or a short? Or, if you’re writing a long novel or a short 
story? Change the page count to see how things fit. The beats and the board will be 
reconfigured for you.


Description

If you have more than one beat sheet, write in a description so you can remember what you are 
going for with each particular beat sheet.


Switch Beat Sheets

Just select a different beat sheet in the drop down. The appropriate beat sheet will be 
displayed along with the active board for that beat sheet.


Deleting a Beat Sheet

Click the tool bar button or the Story then Beats menu then Delete Current Beat Sheet. That 
only shows up if you have more than one beat sheet. You have to have at least one beat sheet. 
If you only have one beat sheet, and you don’t like where your beats are going, you’re just 
going to have to rewrite them.
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Writing Your Beats 
Pick a beat you want to work on and double-click on it in the list or, click the new keyboard 
icon on the beat card. That will put you in the Detail View.


A Brief Interlude 
A couple of new things to point out.


Keyboard Icon 
You may have noticed the keyboard icon on each of the beat cards, among other places. 




When you see the keyboard icon, you’ll know that is something you can edit. Click it to open 
the edit or detail view. Or, you can still use the old method of double-clicking on the card itself.


+ Buttons 
You may have also noticed the little “+” buttons on various category or type cards. Like this 
one.




Clicking the “+” button on a category or type card will add something of that type. In this 
example, a Main Character. No need to go to the toolbar or menu.


Detail View Windows 
So that you can have more information at your fingertips and to give you more flexibility in 
arranging your workspace, you will now have separate windows for beats, characters, 
locations, things, relationships, set-ups, pay-offs, and scenes.


When you open a beat to work on it, it will open the beats window. When you open a character 
to work on it, it will open the characters window.


You can size them and arrange them anyway you like. It’s really handy if you have multiple 
monitors. Or, if you’re working on the script for a scene, you can place the scene window side-
by-side with the characters window and have the character information right there.


Page  of 25 64



Save the Cat! ® 4	 User Guide



Common Detail View Functionality 
Before we talk about the details specific to a Beat, let’s talk about functionality that is common 
to all of the Detail Views. These will include beats, characters, locations, things, relationships, 
set-ups, pay-offs, and scenes.


The Strip

The strip along the bottom contains a “card” for each beat or entity such as character. If an 
entity can have an image attached, the image will be displayed instead of the default icon. The 
card for the particular entity you are working on will have a little line over as an indicator. So 
you know where you are. In the sample above, you are working on the first beat.


Hover your mouse over any of the “cards” to see a preview of that particular item. In the 
example shown, if you hover the mouse over a “card”, a beat card that looks just like the beat 
cards in the list on the main screen will be displayed just above the Strip. Move your mouse 
away to make it go away.


Click on any “card” in the Strip to open that card in the Detail View to work on it.


Navigating

You’ve already learned one way to navigate to a different beat. Or, whatever kind of entity you 
are working on. By clicking on one of the “cards” in the Strip.


You can navigate to the previous item in the Strip by clicking the pointer button on the left side 
of the detail panel. Navigate to the next item by clicking the pointer button on the right side of 
the detail panel. If you are working on the first item in the Strip, the pointer on the left will be 
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disabled. If you are working on the last item in the Strip, the pointer on the right will be 
disabled.


Adding

While in a Detail view, you guessed it, click the “+” button to add a new entity of that type. Like 
a character. Of course, you can’t add a new beat so there is no “+” button for beats.


Deleting

If you’re looking through your characters in the Detail View and decide you no longer need the 
character you are looking at, you can delete it by clicking the trash can and confirming the 
delete. Okay. In our example we are using a beat. You can’t delete a beat.


Detail View Hotkeys

At any time, whether in the main view, you can quickly switch to the Detail View for another 
type of entity. Whichever entity type you choose, it will open to the last one you had open of 
that type. For example, if you last worked on a character named BOB, when you hit the 
hotkeys for characters, it will open to BOB.


Here are the hotkey combinations. You can also find them under the View menu then Detail 
View.

Beats - shift+control+b

Characters - shift+control+c

Locations - shift+control+l

Things - shift+control+t

Relationships - shift+control+r

Set-ups - shift+control+u

Pay-offs - shift+control+o

Scenes - shift+control+s


Don’t forget. All these things I’ve just talked about are common for all the Detail Views so I’m 
not going to repeat them when we move to Locations and other entities.


Back to Beats.
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A Beat 
It’s up to you to come up with your beat so do your best and type it in the big box across the 
top.


Current Logline

The current Logline is shown so you can keep it in mind as you figure out this part of your 
story. If you have a flash of creativity, you can modify your current Logline right here. No need 
to step out of the Detail View.


My Reminders

You can find great information about each individual beat and what it means under the Help 
menu then Advice From the Cat. You’ll find tips for each individual beat.


You may, however, want to describe what a beat means, in your own words. Or, maybe you 
have information that you have learned about what a beat means. My Reminders is the place 
to capture that information. My Reminders are not saved within your project so they will show 
up no matter which project you’re working in.


Notes

We’ll come back to notes later in a section of this document where we talk about notes and 
other items that are common to almost all entities.


Close the Beat Detail View, we’re moving on. Remember how to do that? Click the X in the 
upper right. You are following along, right?
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The Board 
Not so fast. Thought you might have thought we were going there next. There’s a lot more you 
can do with the Board than just arrange your scenes into the best possible order for telling your 
story.


We’ll come back to it in a little bit.


Characters 
Naturally, characters are people and, possibly, animals that play a role in your story. I guess 
they could be other-worldly creatures as well.


Character List 
The Character list is found by clicking the 
second tab in the Beats Section of the 
main view. Remember the Beats section? 
Far left.


The characters are grouped by type. 


Rearrange the order by dragging a 
Character to a new position. Drop the 
Character into the new position when you 
see the blue line in the gap.


You can even drag a Character into a new 
group in order to easily change its type.


Character Image 
For inspiration you can find an image that 
represents the Character you’re creating. 
Just drop it onto the picture for that 
Character. An attachment will be added to 
the project, linked to the Character, and 
assigned as the image for that Character.


If you have other research documents or 
images you want to link to the Character, 
drop them anywhere else on the card.


They’ll show up in the Attachments tab in 
the Character Detail view.


Delete a Character 
Drag the Character’s card to the trash can.


Edit a Character 
Click the keyboard icon or double-click a 
Character card.
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Adding a New Character 
At any time, whether in the Main View or a Detail View, and not just the Character Detail view, 
you can add a new Character. Click the Character toolbar icon and select the type of Character 
you want to add. The new Character will be opened in the Detail View window.





Normally, when adding a new Character, the name will be blank. In fact, everything except the 
type will be blank. The type is automatically selected because you selected the type of 
Character you wanted to add in the first place.


If you start to add a new Character then change your mind, click the Trash can to delete it.


Be sure to check out the Advice From the Cat for more specific info about Wants, Needs, and 
the Six Things That Need Fixing. Or, click the info-dot.


We’ll be covering the seven tabs on the right later because they are, for the most part, the 
same for all entities.


Attachments

One note about attachments. You can drop files, images, etc. pretty much anywhere on the 
Character Detail card to link the attachment to the character. 


If you drop an image or other attachment onto the picture, the image or file icon will become 
the image for the character and will appear in the strip at the bottom and in the Character 
cards on the Board. More on that later. When we really get to the Board.
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Locations 
Locations, of course, are all the interesting places where something happens in your story. 


Find the list of Locations by clicking the third tab in the Beats section of the main view.


I’m not going to show the Locations list because it looks like the Character’s list and works like 
the Character’s list with one exception: Locations aren’t divided into groups or categories like 
Characters. Just a list of Locations. But, you can sort them into the order you want them by 
dragging them up and down in the list until you see the little, blue line.


The same things apply regarding dropping an image onto the picture, deleting a Location, and 
editing a Location.


Adding a New Location 
At any time, whether in the Main View or a Detail View, and not just the Location Detail view, 
you can add a new Location. Click the location toolbar icon. The new Location will be opened 
in the Detail View.




Remember, the name of the Location is required. If you added the Location in error, click the 
Trash can icon to delete it.


Join me later in the document for information about the tabs. Be sure to review the 
Attachments notes above for Characters. The same things apply for a Location.


And, don’t forget, you can quickly open the Location Detail view to the last Location you were 
working on by using the hotkey. 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Things 
Things are new in Save the Cat! Version 4. Things are all the important objects that play an 
important role in your story. You know like the ring in “The Lord of the Rings” movies.


You can view your list of Things by clicking the fourth tab in the Beats section of the main view. 
That is if you have the Premium or Pro plan.


Things are also not divided into groups or categories. And, like Locations, the same things 
apply regarding dropping an image onto the picture, deleting a Thing, and editing a Thing.


Adding a New Thing 
At any time, whether in the Main View or a Detail View, and not just the Thing Detail view, you 
can add a new Thing. Click the thing toolbar icon. The new Thing will be opened in the Detail 
View window.




Remember, the name of the Thing is required. If you added the Thing in error, click the Trash 
can to delete it.


More info coming later about the tabs on the right. Attachments? Yup. Same.
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Relationships 
Relationships are also new in Save the Cat! 4. Relationships are, well, relationships. I know. 
You’re thinking of love stories as having a relationship. But, stories are full of all kinds of 
relationships: family, a gang, police partners. 


In Save the Cat! you are not limited to relationships between two people or even people at all. 
You can establish relationships that include people, places, and things. Okay, Characters, 
Locations, and Things. 


Relationships are divided into categories or types like Characters. 


Relationships List 
The Relationships list is found by clicking the fifth 
tab in the Beats Section of the main view.


The relationships are grouped by type. 


Rearrange the order by dragging a Relationship 
to a new position. Drop the Relationship into the 
new position when you see the blue line in the 
gap.


You can even drag a Relationship into a new 
group in order to easily change its type.


Relationship Image 
Works the same as characters, locations, and 
things. You can see the default image is shown 
here.


Delete a Relationship 
Same. Drag to the trash.


Edit a Relationship 
Same. Click the keyboard icon or double-click the 
card.
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Adding a New Relationship 
At any time, whether in the Main View or a Detail View, and not just the Relationship Detail 
view, you can add a new Relationship. Click the relationship toolbar icon and select the type of 
Relationship you want to add. The new Relationship will be opened in the Detail View.





And yes, the name of the Relationship is required. If you added the Relationship by mistake, 
click the Trash can to delete it.


Relationship Members 
If you’re going to have a Relationship, you have to have someone, some place, or something in 
the Relationship. Those would be the members.


To add a member, select the type of member from the drop down list. Then, click the “+” 
button on the right. This window will open.


The Member drop down will be 
populated with the type of members you 
selected in the previous step. If you’re 
adding a Character, the list of members 
will be characters that are not already in 
the Relationship.


Select from the “As” drop down to 
indicate the role this Member has in the 
Relationship. Type a description for this 
member, if you want to. Click the X when 
you’re done. 


If you decide you didn’t mean to add the 
member, press Esc. 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As you add members to the list, you can rearrange the order by dragging them up or down in 
the list. Remember. Blue line.


Delete a Member

Drag it to the Trash can on the toolbar.


Conflicts/Resolutions 
What would a Relationship be without a few conflicts? And, maybe they get resolved. Maybe 
they don’t.


You can add a conflict/resolution for a Member by clicking the “+” button in the upper right 
corner of the Member’s card in the list. This will pop up.


Fill it in and click the X. Or, press Esc to cancel.


Delete a Conflict/Resolution

Drag it to the Trash.
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Set-ups 
Set-ups are like a seed that you plant then water throughout your story and which eventually 
pays off with a beautiful flower. A flower that, when the viewer looks back, they see where it 
came from. It wasn’t something that just appeared out of the blue and makes no sense.


Set-ups are found by clicking the sixth tab in the Beats section. Unless you have Essentials 
then it will be the fourth tab. You can rearrange them in the order you like. Hint: drag, blue line.


You know the drill about deleting a set-up, by dragging it to the trash.


Adding a New Set-up 
At any time, whether in the Main View or a Detail View, and not just the Set-up Detail view, you 
can add a new Set-up. Click the set-up toolbar icon. It’s the sign post. The new Set-up will be 
opened in the Detail View.





Give it a title and a nice, concise description. 


Link a Pay-off

Each Set-up should link to a Pay-off. When you think you’ve finished your story and you look 
back at all of your Set-ups, each one better be linked to a Pay-off or you might leave the viewer 
dangling.


If you have any unlinked Pay-offs, they will be listed in the “Link to Pay-off” section. Click on 
the correct Pay-off to link it. Once you link a Pay-off, the Pay-off details will be shown instead 
of the list of Pay-offs. Makes sense, right? To unlink a Pay-off, click the “-“ button that will 
appear to the right of the Pay-off title box. You’ll see that in a minute. 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Affects

To create a detailed, effective Set-up, you can add the entities that this Set-up affects. They 
can be Characters, Locations, Things, and Relationships and make notes about how it affects 
each entity.


To add an entity to the Set-up, select the type of entity such as Character (limits the list to 
make things easier) and click the “+” button. This will open.


Select the entity from the drop down list, describe how the entity is affected and click the X. Or, 
press esc to cancel.


After you’ve added entities that are affected, it will look something like this.





To delete an Affects entity, drag it to the Trash.
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Pay-offs 
A Pay-off, of course, is that big reveal that you’ve been setting up throughout your story. 


Pay-offs are found by clicking the seventh tab in the Beats section. Unless you have Essentials 
then it will be the fifth tab. You can rearrange them in the order you like just like all the other 
entities.


I won’t waste your time repeating what you just read about Set-ups. Pay-offs work the same 
way as Set-ups. Except you would link a Set-up to the Pay-off instead of linking the Pay-off to 
the Set-up. Makes sense, right?


When you haven’t linked a Pay-off to a Set-up, the list of unlinked Set-ups will be displayed in 
the list. If the correct Set-up is there, click it to link it to the Pay-off.


A fully developed Pay-off will look something like this.
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Scenes 
Scenes are why you do what you do. Scenes are where you really tell your story. They aren’t 
listed in a tab in the Beats section. They go straight to the Board. Which I’ll talk about later.


One note about scenes and the Board. As mentioned earlier, you can have multiple versions of 
your Board so you can play with different versions or ways of telling your story. When you add 
a scene, it goes onto the Board that you are currently working on. If you have multiple versions 
of the Board, and since you may want to also include that scene on other versions of the 
Board,  the Scene will be placed into the Litter Box for the other Boards. We don’t want to 
assume that you’ll want to include that scene in all versions of your story.


When you fill in the scene heading, description, and other information for the scene, it will be 
the same no matter which Board you have included it on. You write the scene once, but can 
move it around to different locations in your story on each Board.


When you switch to another Board, and you want to include the new scene in that version of 
your story, just drag it out of the Litter Box and onto the Board.


Just remember. If you change the scene, you are changing it for all Boards.


A scene card on the Board looks like this.


	 	 Mac	 	 	 	 	 	 	 Windows


They are a little different due to the platforms but they work the same. Oh yeah, the number in 
the upper right is the page number on which this scene is placed on the Board. It will change 
automatically when you drag the card around on the Board.


Resize a Scene Card

You can now resize a scene card by dragging the lower right corner to make it larger or smaller. 
You will be prevented from making it too small. You still need to be able to read it.


Modify the Scene

You can modify the scene heading, description, emotional change, and conflict right here while 
the card is on the Board. Or, click the keyboard icon to work on it in the Detail View window.


Click the “+/-“ to change the emotional change indicator to indicate a positive change. Click it 
again to indicate a negative change. Click again to remove any indication. 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Color Coding

You can set up to six color codes for a scene. When a project is set up, a card is created for 
each beat and the first color code block is set to the “Major Turns” color code. The cool thing 
about color coding your scenes is that you can filter the Board to show only the scenes that 
have a particular color code. That’s one way you can really focus on a particular aspect of your 
story.


The way you set a color code is to click in any of the color code blocks to open the Color Code 
selector window.


Drag the row and drop it onto the 
particular color code block in the 
particular scene where you want it.


It can be a little tricky in the Windows 
version. The Windows version does 
more within the list. You can edit the 
title of a color code right in the list. 


To drag the color code of your choice, 
move the mouse around in the row 
until the cursor turns into a little hand. 
When you see the hand, you know 
you can click and hold the mouse to 
start dragging.


The color blocks are on the left in the 
Windows version. A good place to 
drag from is just left of the color 
block. In any case, look for the hand.


There is no hand on the Mac version. It 
works easily just clicking and dragging on the text of the color code.


You can also add new color codes, delete color codes, change the color of color codes, and 
edit the titles right in this window. 


In the Mac version, double-click a row to edit the title. In the Windows version, just click in the 
row and edit the title right there.


Click the color block to pick a new color. 


Drag a row to the Trash can to delete it.


Click the “+” button to add a new color code.


Remove Color Code From a Scene Card

Double-click in the color block from which you want to remove the color code.
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Adding a Scene 
Click the Scene button on the toolbar or use the Add Scene option in the Scene menu under 
the Story menu. The toolbar button is much easier. Not sure why we even bother with the menu 
but it’s standard operating procedure to have menus.


The new scene card will be dropped onto the middle of the Board. Move it to wherever you 
need it. That’s that. Don’t forget what I said above about multiple Boards and new scenes.


Deleting a Scene 
Drag a scene to the Trash to delete it. You will be asked to confirm the deletion. Very important 
to remember: If the scene you are deleting is on multiple Boards and you delete it, it will be 
deleted from every Board. If you don’t want to delete it from your other Boards, you should 
move it to the Litter Box instead of deleting it.


Editing a Scene 
You can edit some things about the scene in the card on the Board as I’ve already mentioned. 
To give yourself a little more room to work, you’ll want to open the Scene in the Detail View by 
double-clicking on the title bar of the Scene Card or by clicking the keyboard icon.


The Scene Detail View window will open.





Representative Image

Notice the clapper icon in the upper left. Just like a character, location, thing, or relationship, 
you can have an image that inspires you for a scene. Just drag an image and drop it on the 
clapper icon to set it. 
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And, just like those other entities, you can drop other images and files onto the scene to add 
them as Attachments. Which means, from the Attachments list for a scene, you can drag one 
of them and drop it on the clapper to set it as the image. If you already have an image there, it 
will be replaced.


Location

Every scene occurs at some Location. Pick the correct Location from the drop down. Or, if you 
haven’t created a Location yet that you need for a scene, just type it in. When you exit the 
Location field, you’ll be asked if you want to add it. Click Yes and you’ve got a new Location.


Start Date/Time, End Date/Time

In the Mac version, click the button next to the field to select a date and time, or to clear the 
field. You have to pick it this way because it is just too difficult to interpret the many ways that 
someone might enter a date and time.


In the Windows version, enter a valid date and/or time. If you type something and the cursor 
doesn’t leave the box, you’ve typed an invalid date and or time. Try again.


The Script/Manuscript 
When your project is a movie or tv episode, the word processor will automatically be formatted 
for a screenplay with paragraph elements for: Scene Heading, Action, Character, Dialogue, 
Parenthetical, and Transition.


When your project is a novel, the word processor will be formatted for a manuscript: 12pt 
Times New Roman, double-spaced with a first line indent for each paragraph.


So, be sure to start your project as the correct type. You can’t switch it in the middle.


When working in the screenplay format, press tab when the current paragraph is Action to 
change it to Character. The cursor will be moved to the appropriate location. From there, you 
can press tab again to switch the paragraph to a Transition.


If you’re typing a Character name and you press return, the next paragraph will be set to 
Dialogue. If you need a Parenthetical, type a “(“ and the paragraph will be switched. After 
finishing the Parenthetical, press return to continue with additional Dialogue. After finishing the 
Dialogue, press return to continue with an Action paragraph.


If some paragraph gets a little out of whack due to some odd cutting and pasting, fix a 
paragraph by clicking in it then picking the paragraph element you want from the drop down on 
the left.
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Entity Tabs 
Finally, we’re getting to the tabs that you saw on the right side of the Detail View for various

entities. Remember, entities are (in this case because they all have tabs) Beats, Characters, 
Locations, Things, Relationships, Set-ups, Pay-offs, and Scenes.


They don’t all have the same set of tabs but I’ll point that out as we go along.


Notes 

Okay. Right off the bat. This one applies to every entity. And, it’s just what you think. A place to 
keep all your notes neatly organized.


Remember that every entity type has its own list of Note Types that you can manage in 
Preferences. So the list in the dropdown in the section shown below will be different for each 
entity type.


Adding a Note

Pick the type of note you want to add from the dropdown and click the “+” button. The edit 
window will pop up so you can type your note.


Type your note and click the “X” to save it. Press esc if you changed your mind.


Adding a Note Type (On the Fly)

Type it in the dropdown (either one) and press Tab. You’ll be asked if you want to add it to the 
list.


Rearranging Notes

Drag notes up and down in the list to rearrange the order. You can change the Note type by 
dragging it to a different section in the list. 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Just the Facts 

I talked about what Facts are earlier so I won’t repeat that. Facts apply to Characters, 
Locations, Things, Relationships, Set-ups, and Pay-offs. Why facts for Set-ups and Pay-offs? 
Why not? Just giving you plenty of room for your creativity.


Facts work just like Notes so refer to the Notes section above for adding Facts. Didn’t mention 
it in the Notes section but you should know by now how to delete something. Drag it to the 
Trash.


You can rearrange Facts just like rearranging Notes.




Tracking 

Tracking gets a little more complicated. Not in the way you add tracking for an entity. But, in 
what happens with things you add to Track.


Adding and deleting Tracking items works the same as for Notes and Facts. As does 
rearranging them.


By the way, Tracking applies to Characters, Locations, Things, Relationships, Set-ups, and 
Pay-offs. 


When you drag any of the entities that have Tracking onto a Board, the Tracked items will be 
included. You’ll learn more about this later but, if an entity on the Board has any Tracked items, 
the Tracking icon will be shown. If you click the icon, the card will be expanded to show a list of 
the Tracked items for that entity. 





Initially, the Tracked item shows the overall description of what is being tracked for the entity, a 
character in this example. Click the keyboard icon for the Tracked item to describe where 
things are at this point in the story. Remember, you’re on the Board, and this entity card is 
placed at a particular point in the story.


Everything you’re tracking for an entity will be included in the card. If you add a new Tracking 
item for an entity, it will be added to all of their cards on the Boards.


You can expose or hide the tracked items for all entities at once using the View menu then 
Board then Show All Tracking or Hide All Tracking. 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Boards 
 


This is the place to get a good look at a particular entity’s story. Clicking this tab will show you 
every place the entity appears within the context of a Board.  


If you have multiple Boards, pick the Board you 
want to review from the dropdown.


Every place this entity, and only this entity, 
appears on the Board will be shown. Other 
entities are not included so that you can really 
focus on this entity’s story. 


You can view the Boards for Characters, 
Locations, Things, Relationships, Set-ups, and 
Pay-offs.


If you view the Boards for a Scene, everything 
on the Board will be included so you can see 
the Scene in context.


In the example shown, the Character Bob was 
dropped onto the Board in the Opening Image 
section and the Set-up Cont. section. And, Bob 
has been included in a Scene in the first Set-up 
section.


This is for review only and there is nothing else 
really to do except make sure you have a 
complete, interesting story for the entity.


Page  of 45 64



Save the Cat! ® 4	 User Guide

Relationships 

This tab will show any Relationships in which this entity is a Member. Since only Characters, 
Locations, and Things can be added to a Relationship, this tab is only found in Characters, 
Locations, and Things. Duh.


I won’t repeat the instructions for adding something but, if you add a Relationship for an entity 
here, the new Relationship will be opened in the Detail View, not just a pop up. After all, you’re 
adding a new Relationship.


If you want to edit a Relationship in this tab, double-click on it. It will open in the Detail View.


You can delete a Relationship by dragging it to the Trash from this list. You’ll have the option to 
delete the entire Relationship or to just remove this entity from it.


Set-ups / Pay-offs 

This tab applies to Characters, Locations, Things, Relationships, and Scenes. Remember, the 
Affects section in a Set-up or Pay-off.


Selecting this tab will simply show the list of Set-ups and Pay-offs that this entity Affects. 
Double-click a Set-up or Pay-off in the list to open it in the Detail View.


If you’re in a Scene and looking at the Set-ups/Pay-
offs, things may look a little different.  Since a Scene 
can be on more than one Board, and you can drag a 
Set-up or Pay-off onto a Scene on a Board, that link 
only applies to the Scene on a particular Board.


Whew. That was a mouthful. It means that you may 
plug a Set-up into one Scene in one version of your 
story but plug it into a different Scene in another 
version of your story. 


In the example shown, the Scene is on two Boards. 
Both Boards are versions of the same Beat Sheet: 
Blake Snyder Beat Sheet. In the first Board, the name 
of the Board is the same as the name of the Beat 
Sheet so the Board name is not repeated. 


The second version of the Board is called “Blake Snyder Beat Sheet Copy” so it shows the 
Board name and the name of the Beat Sheet it is linked to.


You can see, in this example, the Set-up is only linked to this Scene as it appears on the first 
version of the Board. The Set-up may or may not be linked to a Scene in the second version of 
the Board. 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Attachments 

Here is where you will find any Attachments you’ve linked to an entity. You can link 
Attachments to Characters, Locations, Things, Relationships, Set-ups, Pay-offs, and Scenes.


Drag them around in the list to rearrange them or to change the Attachment type within the 
entity. Attachments, when linked to an entity can have two types. A type for the Attachment 
itself and a type that identifies how it applies to this entity. 


When you drag and drop a file onto the entity, or, if you double-click an attachment in the list to 
edit it, this pop up will be displayed.


The top section is the information that applies to the Attachment generally. The bottom section 
is how the attachment applies to the entity, a Character in this case.


In the top section, select the Type. This will determine where it is displayed in the general Notes 
and Attachments section of the main window. 


In the bottom section, select the Type to categorize it for the entity it is linked to.


Delete Entity Attachment

When you drag an Entity Attachment to the Trash, you will be given the option to Remove the 
attachment from this entity or to completely Delete the attachment. Make the right choice.
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Scene Characters 

You can link Characters to Scenes by dragging a Character from the list in the Beats Section 
and dropping it onto a Scene card on the Board. This is where you will view the list of 
Characters in the Scene. 


You can also add Characters to the Scene 
here. 


Any Characters that have not already 
been included in the Scene will be 
included in the dropdown. Select a 
Character and click the “+” button.


Fill in what the Character is doing in the 
Scene in the pop up and click the big “X.”


Double-click a Character in the list to edit 
the description of what they are doing in the scene. 


And, of course, (hate to keep reminding you) remove a Character from the Scene by dragging it 
to the Trash.


Scene Things 

These are the Things that are linked to a Scene. Works the same as Scene Characters.


Scene Relationships 

These are the Relationships that are linked to a Scene. Works the same as Scene Characters 
and Scene Things.
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General Notes and Attachments 
Before we get to the Board, let’s cover the General Notes and Attachments section at the 
bottom of the main window.


First, the layout. You have four options for the layout of this section.


My Layout - Well, your layout. This means you put the Notes and Attachments wherever you 
want them. 


If you feel like more structure:


Notes then Attachments - This places a header for each of your Note types that you’ve 
configured in Preferences across the top followed by headers for each of your Attachment 
types. Then, a card for each Note is added under the appropriate type header. Same for your 
Attachments.


Attachments then Notes: You guessed it. The Attachment type headers are first, then the Note 
type headers.


Alternating Layout: Your first Note type is followed by your first Attachment type, and so on.


You can select the layout under the View menu then Notes Layout Style. 


You can arrange the order of the Notes or Attachments within a column by dragging them up or 
down.


You can change a Note or Attachment from one type to another by dragging it to a different 
column.


Adding a Note

You can add a Note by clicking the Note icon on the toolbar then selecting the Type you want 
to add. The Note pop up will be displayed so you can type the note. Click the “X” to save it.


Or, you can double-click in the Notes section. If you’re in My Layout, the note will be placed 
into your last Note type but you can change it in the pop up. If you are in any other layout, 
double-click in the specific column to add a Note of that type. Change it if necessary.


Adding an Attachment

The easiest way to add an Attachment is to just drag and drop a file onto the Notes and 
Attachments section. If you’re in a structured layout, drop the file into a specific Attachment 
column to have it set to that type. 


Or, you can click the Attachment toolbar icon and select the type you want to add. A file 
selection window will open so you can select the file to add as an Attachment. After you select 
the file, the pop up will open so you can select the type and add any notes.


Did I mention that you can also add Attachments by dropping files onto a Character or other 
entity in the main list in the Beats section, or by dropping them onto the entity when it’s open in 
the Detail View. And, if you drop it onto the picture, the attachment will be used as the 
representative photo for the entity.
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The Board 
Finally!


We have finally arrived at the center-piece of Save the Cat! The place where you plot your 
story. We’ve hit on several things that tie in to the Board but let’s get into the nitty-gritty.




The view shown has the Title/Logline section and the Notes/Attachments section hidden to 
make more room for the Board while keeping the Beat Section visible for easy access to our 
Characters, Locations, etc. And, for now, I’ve left the Litter Box visible.


The Board is divided into rows, one for each Act. And, each row or Act border at the bottom 
that shows how the Beats fit into the Act. That way you can place scenes and other objects 
into the correct beat as you lay them out on the Board.


Board Entities 
You can plot individual character’s stories on the Board. You can also plot the stories for 
Locations, Things, Relationships, and even the development of Set-ups and Pay-offs.


Just pick the tab in the Beats section for the type of entity you want to place on the Board than 
simply drag and drop their card onto the Board at all of the appropriate locations in the story. 
Don’t worry, you can move them around as needed.


When you drop an entity onto the Board, a pop up will be displayed so you can describe what 
is happening with that entity at that point in the story. You’ve seen this pop up before so type in 
the description and click the “X” to save it.


Don’t forget what you learned about Tracking. If you have set up something that you want to 
track through the story for a Character or other entity, the tracking icon will appear on their 
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cards on the Board. Click it to expose the tracked items so you can also edit the description as 
to where things are at that point in the story for each tracked item.

Sequence 
In addition to dropping various entities onto a Board, you can also combine Scenes in to a 
Sequence. We talked about setting up your color-coded Sequences in the Make It Your Own 
section. 


To add a Sequence, click the Sequence button on the Board toolbar then pick the 
Sequence type you want to add.


Drag one or more Scenes and drop them onto the Sequence card. It looks a lot like a Scene 
card.


Labels 
If you need a note or something on a Board that isn’t an Entity, or a Scene, or a Sequence, you 
have Labels at your disposal. Like Sequences, you learned about configuring your own list of 
color-coded label types in the Make It Your Own section.


To add a Label to a Board, click the Label button on the Board toolbar then pick 
the Label type you want to add. Type in the description in the pop up.


Labels can be resized as needed. Just drag the lower right corner.


Delete Items from the Board 
If you want to delete an item from the Board, press the control key on the keyboard then drag 
the item you want to remove. Once you start dragging, you can release the control key. 


In the Windows version, as soon as you start dragging, the cursor should change to a black 
circle with a line through it, indicating that you can’t drop the item there. Once the mouse is 
over the Trash Can icon on the toolbar, the cursor should change to a miniature version of the 
object. If it doesn’t, you’re likely not over the trash can.


Once over the Trash Can, drop the item and confirm that you really want to delete it.


Litter Box 
If you want to remove an item from the Board but not delete it, drag it into the Litter Box using 
the control key method described above. You can drag Scenes, Sequences (we’ll get to them 
in a minute), and individual Board Entity cards into the Litter Box. Board Entity cards are the 
cards that are created when you drop a Character or other Entity onto the Board.


If you want an item back in your story, drag it out of the Litter Box and drop it onto the Board 
where you want it.


One note, if the Litter Box itself is hidden, you can drag items onto the Litter Box icon on the 
toolbar. If the Litter Box is showing, drag the item directly into the Litter Box. The item will be 
displayed in the beat section where it was originally on the Board so you can remember where 
you had it in the first place.


Multiple Boards 
If you have created multiple Boards for a Beat Sheet, you switch between them by selecting a 
Board in the dropdown in the Board toolbar.
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The Board’s name defaults to the name of the Beat Sheet that it is linked to but you can 
change it. Just change it. When you tab out of the drop down, you’ll be asked to confirm the 
change.


Add/Copy a Board 
You can create a new version of a Board for a Beat Sheet by adding a new empty Board or by 
copying the current Board. 


Click the single pin icon on the Board toolbar to add an empty Board. New Board Entities for 
each Scene will be created and placed into the Litter Box. It is up to you to place them back 
onto the Board where you want them for this version. If you’ve dropped other entities such as 
Characters onto the original Board, they won’t be copied to the Litter Box. You’ll just need to 
drag them from the Character or other list again. After all, you wanted a blank Board.


If you want to copy the Board with all of its objects so you can keep all the objects but have a 
way to rearrange them, click the icon with the two pins on the Board toolbar. 


Delete a Board 
While we’re on the subject of adding and copying a Board, might as well talk about deleting a 
Board. If you just don’t like the way a version of your story is working out you can get rid of it. 
Click “Delete Current Board” under the Board menu. We’ve given this delete a special menu. If 
you only have one Board, you won’t be able to delete it. You’ve got to have a Board.


Resize the Board 
When you start to get a lot of items on the Board, you may find that you need more room. More 
room within an Act and more room within a Beat.


Click the Resize button and set the new width and height you want for the Board.




There are limits so don’t get carried away. But, you can give 
yourself plenty of room to maneuver. 


Size to Fit means that it will try to fit the Board into the visible 
window so you don’t have to scroll. For the most visible 
space, make the Board the Full View. Then, use the Size to 
Fit.


Zoom the Board 
You can now zoom each board independently from the main layout. This gives you even more 
control over how much you can see on the board. Zoom in to focus on a smaller area or zoom 
out to see the big picture. 


You’ll find board zooming under the Board menu. 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List View 
If you need a new perspective on your Board, you can switch to List Layout. Find it under the 
View menu then Board. Looks kind of like this.





 In List View, you can rearrange an item by dragging it until you see the blue line in the gap 
indicating a location where you can drop it.
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Filter the Board 
One of the coolest features related to the Board is the ability to filter the Board by indicating 
which objects or even specific entities you want to have visible on the Board.


Click the Filter icon on the Board toolbar. 




Show Everything / Hide Everything

If you’ve been playing around trying different combinations and you just want everything to 
show, click Show Everything. If you want to just pick a couple of items to show, start by 
clicking Hide Everything then select individual items.


All / None

For a particular entity type such as Characters, you can quickly select “All” Characters or 
“None”. 


Characters / Relationships

For these two types which are grouped by types, you can select all of a type by clicking on the 
type row in the list when it’s not checked. Or, unselect all of a type by clicking the type row in 
the list when it is checked. All entities in that type will be checked or unchecked accordingly,


Individual Items

Otherwise, check and uncheck individual rows to include or exclude individual items.


Scene Cards

Scene cards can be visible or hidden based on selected color codes. Check or uncheck 
individual color codes to show or hide the applicable scenes.
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Labels

You can also hide or show Labels on the Board by unchecking or checking the Show Labels 
checkbox.


Apply

Once you’ve made all of your selections, click Apply to reset the objects on the Board 
according to your filtering requirements.
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Novel by Chapter Board 
If you have the Premium or Pro plan, you may be working on a Novel by Chapter project. This 
type of project doesn’t use a Beat Sheet. Instead you break out your novel into sections with a 
number of chapters in each section.


You will then work from a Board that has a row for each section with each row divided by the 
number of chapters in the respective section.





You can see how the first row of the Board is titled, “The Story Begins.” This is the name of the 
first section of the novel. Hopefully, you’ll have more creative section titles. 


That first section is divided into quite a few chapters. You can also see them listed on the left. 
Click the keyboard icon for a chapter in the list to change its title.


Just like any Board, you can add Scenes, drag Characters and other entities onto it, add 
Sequences, and Labels. And, drag items to and from the Litter Box. Remember, if you the Litter 
Box isn’t showing, you can drag items to the Litter Box icon on the toolbar.


Rearrange Chapters 
As you’re figuring out your chapters you may decide that a particular chapter would work 
better in another spot. Just drag the chapter to a new location in the list until you see the little 
blue line and drop it. You just rearranged the order of your chapters.


Deleting a Chapter 
Drag it to the Trash. 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Series Board 
If you have the Pro plan, you may be working on a series of movies or novels or a tv series. The 
Board looks similar to the Novel by Chapter Board.




With a series Board, you’ll have a row for each season. Each row will be divided into sections 
for each of the episodes in the season.


In the example you can see the season 1 section with the episode titles across the bottom. The 
list on the left also shows the first season with each episode listed.


Switch seasons by selecting another season in the dropdown in the “Beats” section at the top.


You can drop Characters, Locations, Things, Relationships, Set-ups, and Pay-offs onto the 
Board and add Labels. You can only add Scenes within a specific episode.


Develop an Episode 
Click the keyboard icon on an episode in the list on the left to open it in its own window with its 
own Beat Sheet and Board. Remember that Characters, Locations, Things, and Relationships 
are shared across all episodes. You may have Set-ups and Pay-offs at the series level but they 
are not shared with episodes. You’ll create Set-ups and Pay-offs within each episode that are 
applicable to the episode.


Reorder Episodes 
In the midst of developing a series you may decide that an episode would work better in 
another slot. Just drag an episode in the list to a place where you see the little blue line and 
drop it in. You just changed the order. The Board will refresh.
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Delete an Episode 
Drag it to the Trash. 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Find / Replace 
Sneaking in under the Radar of the Edit menu is Project Find and/or Replace.

Performing a search here will allow you to search virtually everything for a word or part of a 
word. If you want to search everything, click the “Select All” button. All the boxes will be 
checked for you. Clear all the checkmarks by clicking the “Clear All” button.




One note. The Windows version does not have the Trash can icon.


Search Entities

To limit where you want to search you can pick certain entity types to search in. Select the 
entity types you want to search by checking the appropriate boxes.


Search In

If you chose to search one or more entity types, you will need to further specify which areas of 
information within an entity you would like to search. Select one or more of these areas and 
you are ready to perform a search.


Also Search In

You can also select these other areas to search that aren’t necessarily linked to an entity. You 
must at least pick one entity type and area or an “Also Search In” in order to perform a search.
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Find

Once you have made some valid selections of places to search, click the Find button. Anything 
that matches will be added to the Found list. The Found list will try to be as informative as 
possible as to where the match was found. 


In this case, “love” was found in the Wants text for the character ELISA. If you double-click on 
an item in the Found list, you will be taken to that match. And, the match will be highlighted. 
That doesn’t really show in the screen shot but it’s there.
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Clear Results

Multiple searches will keep adding items to the Found list without removing items that are 
already in the list from previous searches. Use the “Clear Results” button to remove all the 
previous found items.


Replace All

If you want to replace the text you found with other text, type it in the Replace With box and 
click the “Replace All” button. 


If you’ve performed a search but don’t want to replace the text in every instance of a match, 
and you’re using the Windows version, just drag the items you don’t want to replace out of the 
Found list and drop them into the air. 


If you’re using the Mac version, drag the items into the Trash to remove them from the list.


Once you have the list narrowed down, click the “Replace All” button.
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Export Your Script/Manuscript 
If you’re working on a screenplay or a manuscript, you can export the script related elements 
to Final Draft. This process will export your characters, locations, scenes, scene descriptions, 
and the script you have typed. 


Once in Final Draft, to see the scene descriptions, you’ll have to switch to Scene View.


Identifiers for each scene are also exported to the Final Draft file. This allows you to use Final 
Draft to make changes to the script including adding new scenes. Then, you can import the 
script back into your Save the Cat! project. Any changes you made for scenes that you had in 
your project will be updated and any new scenes you added in Final Draft will be added to the 
Board.


If you are working on a novel, you can also export your scenes to a text file that you can then 
manipulate as needed for importing into publishing software. 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Greenlight Checklist 
We’ve come a long way. We’ve covered a lot. We have one more thing that you might find 
helpful.


Use the Greenlight Checklist to help you determine whether your story is ready for prime time.


You’ll find it under the Story menu then Review. 




Review each topic and the related questions. If you can check all the boxes, you are ready to 
go. Good luck and we wish you much success.
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One Last Thing 
To get a more visual look at many of the things I’ve talked about in this user guide, check out 
the Quick Tour video in the How-To Videos section of the Help menu.


Thanks for listening. Well, reading.


Hope you enjoy using Save the Cat! 4.
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